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Learning Guide for User Interface 4.3 
 

This guide will help you learn how to use Datatel User Interface 4.3. It includes instructions for 
accomplishing various tasks, such as accessing a screen or mnemonic, saving your work, and using 
online help. 

 

 

The UI Window 
If you are familiar with the Datatel UI Desktop or UI Web interfaces, you may notice that this 
interface is very similar, but with some features not previously available. Below, Figure 1 is an 
example of the new Datatel User Interface 4.3. Additional details on the various sections of the 
interface can be found in the “Parts of the UI Window”.   Form Scale Slider 

          Menus Form Area  Toolbar  Tabs         Context Area       Form Print Button 

             Search Area      Figure 1: The UI Window      
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Parts of the UI Window 
Search Area 
The search area of the UI window, in the upper left corner (see Figure 2), lets you search for 
people or forms to work with. You can click the icon to the left of the search text box to switch 
between searching for a person (human figure icon) or a form (computer screen icon). In this 
area, you can also expand the search box to view previous searches or click Edit Search History 
to clear some or all of your search history. 

      
         Figure 2: The Search Area 

 
 
 

Tabs 
 

Figure 3 shows the following tabs available in the UI Window. 
• Search Results Tab. When you search for a person or form, the search results appear on 

the Search Results panel. Search results from other LookUps are also displayed on the 
Search Results panel. This panel is hidden after you select the records or form you want. 
When the panel is hidden, you can click the Search Results tab to return to the results of 
the last search. If the person icon is selected in the search area, the last person-related 
search results are shown. If the form icon is selected in the search area, the last form 
search results are shown. 

• Navigation Tab. Click the Navigation tab to access a Datatel form by navigating through 
the menu structure, which you can use to view and access all menus and forms that you 
have permission to use. Use the Application drop-down menu to view the menu 
structure for any available application. 

• Favorites Tab. Click the Favorites tab to access all forms that you have saved as Favorites. 
You can save an item to Favorites by clicking the Add to Favorites (gold star) button in the 
UI Form Area (for forms), or while in the Favorites panel. 

 
  
 

Figure 3: Tabs in the UI Window 
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Menus 
With UI 4.3, menu items are available on the left side of the tool bar (which is just above the 
form area). These menus provide access to many of the UI controls and features. 

 

 
File Menu 
The File menu provides access to the following features. Many of these features are also 
available using keyboard shortcuts: 

• Save:  Saves data on the current form 
• Save All:  Saves data on all open forms 
• Cancel:  Cancels changes on the current form 
• Cancel All:  Cancels changes on all open forms 
• Detail:  Accesses the detail form (or menu of available forms) from the current field 
• Add Active Form to Favorites:  Adds the current form to Favorites 
• Print Form:  Prints the current form (size is optimized for the page). 
• Logout:  Proper method to exit UI 

 
 

Options Menu 
The Options menu provides access to the following features. Many of these features are also 
available using keyboard shortcuts: 

• Preferences:   Accesses the Preferences dialog box, where you can change 
preferences such as the color theme, font size, and other settings 

• Clear Search History:  Accesses the Clear History dialog box, where you can clear search 
history, contexts, and form scale values. See the online help for the Clear History dialog 
box for more details about this feature 

• Reload Colleague Session:  This option lets you refresh your session with software 
updates that may have been made or loaded into the environment while you were 
logged in. This feature is used primarily in Colleague development environments 

• Show Field Sequence:  Shows the current tab sequence for fields on the current form 
• Disable Custom Field Sequence (if available): Restores the default tab sequence for 

fields on the current form. If selected, this option applies to all forms in a UI session until 
this option is cleared 

• Customize Field Properties (if available):  For the current form, allows the user to 
customize the default tab sequence for fields and mark fields as required. See the online 
help for the Customize Field Sequence & Properties dialog box for more details about 
this feature 
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• Set Form Scale Default:  Sets the global default scale factor for all forms to the current 
scale factor (set using the slider bar at the top of the UI form area). Forms with 
individual scale factor overrides are not affected by this global default 

• Clear All Form Scale Values:  Clears all individual form scale factors and the global 
default scale factor. Without these scale values, forms are rendered using a “best fit” 
algorithm based on the size of the UI window 

 

 
Help Menu 
The Help menu provides access to process and field help for the current Datatel form. It also 
provides access to the quick tour, a list of all keyboard shortcuts, and a Help About message that 
provides information such as the current UI version number. 

 

 
The Context Area 
The Context Area (see Figure 4) displays one or more “cards,” which contain information about 
the current person-related records that you are working with. The Context Area currently 
displays information only for person-related forms. 

 
If the Context Area is blank, use the Person search feature to select Person or Organization 
records to work with. When you open the selected records, they are loaded into the Context 
Area as “cards.” If you have opened a person related form first (with no cards in the Context 
Area), you can use LookUp to search for records and load them into the Context Area as cards. 

 
                     Figure 4: The Context Area 
 

 
 
 

The Form Area 
The Form Area displays the Datatel forms that you are currently working with. See Figure 1 on 
page 1 for an example of the Form Area.  
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Datatel Forms in UI 
This section describes each part of the form in more detail and provides information on how to 
use the features within a form. 

 

 
Form Mnemonic and Name 
The form name and mnemonic for the current form are displayed on a tab at the top of the 
form, just below the tool bar (see Figure 5). If one or more detail forms are also open, a tab is 
displayed for each form. The form’s mnemonic provides you with a quick way to identify a form. 

 

 

 
Figure 5: Form Mnemonic and Name 

 
 

Fields 
A field is any place on the form where data is displayed or where you enter data. In most cases, 
each field is accompanied by a field label indicating what kind of data belongs in the field. 

 

 
Tables 
A table within a form is a set of related fields. A table can have a different value on each line, or 
row. Furthermore, there are usually several fields in each row of a table that are associated with 
each other in some way. Some tables are row-oriented and some are column-oriented. In either 
case, the intersection of a column and a row is referred to as an element. 

 
 
Table Operation Button 
A Table Operation button, Figure 6, enables you to insert or delete a row of data within a table. 

 
 

 
      Figure 6: Table Operation Button 

 
 

When you click the Table Operation button, a dialog box is displayed, as shown in Figure 7. 
 
 

 
Figure 7: Select Table Operation Dialog Box 
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From the Select Table Operation dialog box, select one of the following options: 
• Click Insert to insert a new row above the current row. 
• Click Delete to delete the current row. 
• Click Cancel to leave the row unchanged and return to editing. 

 
 

Scrolling and Exporting 
When your cursor is within table, a controller appears at the top of the table that lets you scroll 
through the rows and pages of data (see Figure 8). This controller also includes a Background 
Toggle button that lets you make the background transparent and an Export button that lets you 
export the entire contents of the table to an Excel spreadsheet. 

 
If the controller blocks your view of another field on the form, you can click and hold the word 
“Page” on the controller to grab it, then move your mouse to slide it left or right. Release the 
mouse button to let go of the controller when it is at the desired location. 

 
When the last row of data in the table is shown, you can click Next Page to access a new blank 
row. If the form allows it, you can add new data on this blank row. 

 

 

 
Figure 8: Scroll and Export Controller 

 
 

Detail Button 
Some forms give you only limited or summary information about a certain item, but provide you 
with the capability of moving to another form. This form, which is known as a detail form, 
provides more complete information on that item. 

 
You will know a detail form is available from a field if there is a Detail button to the right of the 
field. Such fields are referred to as detail fields. See Figure 9 for an example of a detail field with 
a detail button. 

 

 

 
Figure 9: Detail Button 
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Date/Calendar Button 
A Date/Calendar button appears to the right of each date field. 

 
Click the Date/Calendar button to display the calendar browser, as shown in Figures 10 and 11. 
Click the desired date in the calendar to select it. 

 

 

 
Figure 10: Date/Calendar Button 

 
 

 
Figure 11: Calendar Browser 

 
 

Drop-Down List Button 
A Drop-Down List button, as shown in Figure 12, appears to the right of each field that has a 
predetermined set of valid entries. Click the Drop-Down List button to display a list of valid 
codes. Click the appropriate code to select it. 

 

 

 
Figure 12: Drop-Down List Button 
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Person Search 
When you use Person Search or LookUp to search for person records (individuals, organizations, 
staff, etc.), the results are displayed on the Search Results panel. The Search Results panel has 
two views: card view and grid view. Each of these views is discussed in more detail in the 
following sections. 

 

 
Person Search Results Panel: Card View 
When you search for a person or corporation, the search results show all records that match the 
search criteria you entered.  
 
To switch between Card View and Grid View, click the Card View or Grid View button at the top 
of the Search Results panel (see Figure 13). 
 
 

                                                    Figure 13: Person Search Results, shown in Card View 
 

                  Card View Button         Grid View Button         Select All Check Box      Add New Record Button (disabled) 
                                      

 
 

                                 Collapse Button       Export to Excel Button   Select # Field           Open Button 

 
 

Selecting Records 
To select a record to work with, click anywhere on the card. When you click anywhere on a card, 
the color changes to indicate that it is selected. You can double-click on a single record to select 
it and open it in the Context Area. 
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                   Figure 14: Selecting Records Example 

 

 
 
 

To select multiple records, click on more than one card. Click on a selected card again to cancel 
the selection. 

 
In the Select # field, you can also enter the numbers of the records that you want to select, 
separated by commas for individual record numbers. Use a dash to enter a range of record 
numbers. 

 
Use the Select All check box to select all search results. This option selects all pages of search 
results, not just the current page of results. 

 

 
Exporting Records 
To export search result records to a Microsoft Excel spreadsheet, click the Excel icon (to the left 
of the Select # field). All search results records are exported to a spreadsheet. If the browser 
does not automatically open the spreadsheet, you are prompted to open or save it. When the 
export is complete, you can close both the informational window and dialog box. 

 
 

Adding a New Record (if allowed) 
If you cannot find the record you want in the search results, enter A at the Select # text box or 
click the Add New Record button at the top of the Search Results panel. If adding a new record is 
not allowed, this button is not available (grayed out). Be sure to follow your institution’s record 
search procedures to search existing records thoroughly before adding a new record (to reduce 
the occurrence of duplicate records). When you click the Add New Record button, the search 
panel is collapsed, and you are able to enter information for the new record on the UI form 
presented. 

 

 
Filtering Results 
If your search results contain both person and organization records, you can use the filter 
feature to show only person records (individuals), organization records (organizations), or both 
(combined). To filter your search results, click the Filter drop-down and select the option that 
you want to use for filtering. 
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Sorting Results 
Sorting search results is available only in Grid View. To sort search results, first switch to Grid 
View by clicking the Grid View button at the top of the Search Results panel if necessary. In Grid 
View, you can sort the search results by any available column. Click once on a column header to 
sort the results by that column in ascending order (low to high or alphabetical), then click the 
column again to sort the results by that column in descending order (high to low or reverse 
alphabetical). 

 
                                     Figure 15:   Search Results, shown in Grid View 
                                                             Click on Column Header to Sort 
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Form Search 
When you search for a form, the search results show all records that match the search criteria 
you entered. 
 
The results are displayed in Grid View, with the results in rows and columns. Icons also indicate 
the type of form (maintenance, inquiry, report  or procedure). You can sort the results on any 
available column. You can resize the columns if needed, and you may have to scroll horizontally 
in the Search Results panel to see all available columns. 

 
In most cases, when you enter a mnemonic in the form search text box, that form appears right 
away and the search results are not shown. If a mnemonic exactly matches the form search 
term entered, that form opens. If you enter a word or part of a word in the title of a form, the 
Search Results panel shows all forms that match the criteria entered. 

 
To immediately open a specific application/mnemonic pair, enter your search as application- 
mnemonic, such as ST-CREN. Forms opened in this way are not stored in your search history. 
Also, forms that require an explicit selection of the application to open will prompt you for the 
application when loading.  When you see the Form Search Results panel, you can either select 
one of the forms shown or start a new search. 

 

 
Selecting a Form 
To select a form from the Form Search Results panel, click anywhere on the row for that form. 
You can only select one form from the Search Results panel. The selected row changes color to 
show which form is selected. 

 

 
Opening a Form 
To open a form from the Form Search Results panel, double-click on it. You can also open the 
selected form by clicking Open. 

 

 
Sorting Results 
Click once on a column header to sort the results by that column in ascending order (low to high 
or alphabetical), then click the column again to sort the results by that column in descending 
order (high to low or reverse alphabetical). 

 

 
Returning to Your Most Recent Set of Search Results 
To return to the most recent form search results, select the Form option in the search area and 
then open the Search Results tab. Select the Person option in the search area to see the most 
recent person search results. 
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Favorites Panel 
Use the Favorites panel to retrieve and manage saved people or forms. To access the Favorites panel, 
click the Favorites tab. See Figure 16 for an example of the Favorites Panel. 

 
                                          Figure 16: Favorites Panel 

                                         People Favorites                                        Folder of Form Favorites      Form Favorites           Add to Favorites 

                                                        Button 

 
                                                                                                                          Form Favorites Option Button            Favorites Help   
               
 
 

Adding a Form to Favorites 
To add the current form to your Favorites, click the Add to Favorites (gold star) button in the upper 
right corner of the UI Form area. 

 
You can also add active form to your Favorites by clicking the Add to Favorites button (gold star) directly 
in the Favorites panel. 

 
When you click the Add to Favorites button, the Add to Favorites dialog box appears. You can select an 
existing folder or create a new one to store the selected Favorites. For more details on how to use the 
Add to Favorites dialog box, click the Help button in the dialog box. 

 

 
 

 
Selecting a Form from Favorites 
You can only select one form at a time from Favorites. Navigate through the folders to locate the 
form you want. Click the form to highlight it, and then click Open. 

 

 
Managing Favorites 
From the Favorites panel, you can drag items from one folder to another. You can also drag entire 
folders to different levels within the folder structure. 

 
In the upper right corner of the People Favorites area and the Form Favorites area, there is an 
Options button with a drop-down list of available options. Use these options to manage your 
Favorites: 
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• Collapse All:  Use this option to collapse all Favorite Form folders 
• Expand All:  Use this option to expand all Favorite Form folders 
• Rename:  Use this option to edit or rename a folder or item in your list of saved forms. Highlight 

the folder or item you want to rename, and then select Rename from the Options button drop-
down menu to edit or rename the selected item. 

• Remove Selected:  Use this option from the Form Favorite Options button to remove one or 
more forms or form folders from your Favorites. Select the items you want to remove, and 
then select Remove Selected from the Options button drop-down menu to remove them from 
your Favorites. 

 

Using the Report Browser 
The Report Browser allows you to view or print reports generated from Datatel. Follow the procedure below to 
generate and browse a report in Datatel. 

 
Procedure for Browsing a Report 
To use the Report Browser, perform the following steps. 

 

 
Step 1.   Access and complete the Datatel form that creates the desired report.  For example, the XQTP 

> XD34: Objects Sorted by Umbrella report. When you update from the form, the Peripheral 
Defaults form is displayed. 

 

                                                            Figure 17: XQTP > XD34 Report   – Example Only 
 

 
 

 
 

Step 2.   In the Output Device field on the Peripheral Defaults form (see Figure 18), select 
Hold/Browse File Output. When you update from the Peripheral Defaults form, the Process 
Handler form is displayed. 

 
                                                                 Figure 18: Output Device Field: Peripheral Defaults Form 
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Step 3.   If the Execute in Background mode screen appears, simply click Save and Update, 
and the report is generated. 

 
 

                                             Figure 19: The Background Mode Form 
 

 
 

Step 4.   If the progress bar dialog box is displayed, monitor the progress of the batch or report and 
click Finish when processing is complete. 

 

 
Step 5.   When you click Finish from the progress bar dialog box, the Report Browser is displayed. 

Figure 20 shows a typical report page in the Report Browser. 
 

 
Figure 20: Report Browser 

 

 
Step 6.   Use the toolbar buttons, shown in Figure 21, to navigate through the report, print the 

report, or save a copy. 
 

                                       Figure 21:  Report Browser Toolbar Detail 
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Table 1: Detail Description of Report Browser Toolbar Buttons 
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Keyboard Shortcuts 
This section lists the keyboard shortcuts that you can use with UI. 

 

Screen/Mnemonic Shortcuts  
The keyboard shortcuts listed below are available only when working within a UI form 
(alternative keystroke combinations are separated by | ). Most of these commands are also 
accessible with the mouse from the UI form screen/mnemonic. 

 

• Field delete in a table: Ctrl+Alt+D 
• Cancel from current form: F8 
• Cancel from all forms: Shift+F8 
• Finish from current form: Ctrl+F9 (Windows) | Ctrl+9 (Mac) 
• Save current form: F9 | Ctrl+0 (zero, not the letter o) 
• Save all open forms: Shift+F9 (Windows) | Ctrl+8 (Mac) 
• Detail: F2 
• Print active form: Ctrl+Alt+P 
• Show Keyboard Shortcuts: Ctrl+Alt+K 
• Move to the next field: Tab 
• Move to the previous field: Shift+Tab 
• Open a drop-down list to select a value: Down Arrow 
• Scroll through the values in a drop-down list: Up/Down Arrow 
• Select the highlighted value in the drop-down list: Enter 
• Move forward one row in a table: Down Arrow * 
• Move back one row in a table: Up Arrow * 
• Move forward one page in a table: Page Up 
• Move backward one page in a table: Page Down 
• Move to the previous form: Ctrl+Page Up (Windows) | Command+Page Up (Mac) 
• Move to the next form: Ctrl+Page Down (Windows) | Command+Page Down (Mac) 
• Move to the beginning of the current field: Home 
• Move to the end of the current field: End 
• Move to the first row of a table: Ctrl+Home 
• Move to the last row of a table: Ctrl+End 
• Field insert in a table: Insert 
• Help: Ctrl+Alt+H | F1 (shows help for area currently in focus; F1 may not work in all 

instances) 
• Change focus to UI Form Menu Bar (then use tab and arrow keys to access menu items): 

Ctrl+U 
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UI Shortcuts 
The shortcuts listed below are available in UI when you are not working within a UI form. 

 
 

• Show Keyboard Shortcuts: Ctrl+Alt+K 
• Change focus to search box (toggles between Person and Form search): Ctrl+Shift+S 
• Show Search Results panel: Ctrl+Alt+R 
• Show Clear History dialog box: Ctrl+Alt+T 
• Show Advanced Person Search dialog box: Ctrl+Alt+A 
• Show Navigation Panel: Ctrl+Alt+N 
• Show Favorites Panel: Ctrl+Alt+F 
• Exit/Logout: Ctrl+Alt+L 
• Show Debug Information: Ctrl+Alt+B 
• Show Help (for current UI area in focus): Ctrl+Alt+H 
• Show Keyboard Shortcuts: Ctrl+Alt+K 
• View all records in Context Area (card selector drop-down): Ctrl+Shift+A 
• Map current record in Context Area: Ctrl+Shift+M 
• Map all records in Context Area: Ctrl+Alt+M 
• Close current record in Context Area: Ctrl+Shift+X 
• Close all records in Context Area: Ctrl+Alt+X 
• Add current record in Context Area to Favorites: Ctrl+Shift+V 
• Add all records in Context Area to Favorites: Ctrl+Alt+V 
• Go to next record in Context Area: Ctrl+Shift+N 
• Go to previous record in Context Area: Ctrl+Shift+R 
• Open Copy Window for current card in Context Area: Ctrl+Shift+C 
• Close open panels (and return to the main UI window): Esc 


